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Introduction 
This User Guide describes the procedures involved awarding special maintenance contracts in 
the Trns•port Letting and Award System (LAS). 

When district let projects are ready to bid, they are passed by means of a change of the control 
group of the proposal and each attached project to district estimators and then to the District 
Contracts Administration Office.  Some contracts will be processed completely in the 
maintenance organization.  These are MOAs, POs, Contractual Services Contracts, and some 
emergency contracts.  All contracts are transferred to SiteManager for administration of the 
work. 

These special maintenance contracts may not require all of the steps of a competitively bid 
contract but many critical actions in the lifecycle of a contract award must still be performed.  
Specifically: 

 In PES run a Preliminary Detailed Estimate to set fields for eventual transfer to 
SiteManager.   

 In LAS each proposal must be initialized. 

 In LAS every contract must have a Bid Tab Edit generated to set fields for transfer to 
SiteManager. 

 In LAS every contract must have a Bid Tab or Bid Tab Analysis generated to set fields 
for transfer to SiteManager. 

 

The Advertisement phase 
Creating a Letting 

This Guide describes how this is done in 
Trns•port LAS, but Letting Headers may 
also be created in PES. 

• Click the Bid Lettings       button 
on the button bar, 

The Lettings List window will open.  This 
window lists all letting records.   

To create a new Letting, 

• Rclick anywhere in the window. 

• Click Tabbed Folder Add.   
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The next screen displays the Add Letting 
Detail window. 

This screen requires that only two fields 
be completed, Letting Number and Date 
of Letting. 

Enter information for fields that are 
appropriate. 

 
NOTE: Earlier practice has been to establish some special letting headers for 

Maintenance contracts and to use them for an extended period.  This is not 
good practice as critical dates in SiteManager are compromised.  The best 
plan is to always have the Date of Letting be a short time before the Award 
Date of the contract so that when both dates transfer to SiteManager they are 
in logical sequence. 

The Letting Number may be composed of any combination of up to eight numbers and letters.  
For regular lettings in the districts, allocate two positions for the district number, two for the 
year, two for the month, and two for the date, in the form of ##YYMMDD, where ## represents 
the district number.   

If these special letting headers are in the form of ##MYYMM, (District Number, Maintenance, 
Year, Month) one position is available if additional lettings are needed in the month.  
##MYYMMA 

This screen illustrates this numbering 
system for a District 1 letting for January 
2006 (01M0601). 

• At minimum enter the following 
information: 

Letting Number  Date of 
Letting (Transfers to 
SiteManager) 

• Click the "X" in the upper right 
corner of the Add Letting Detail window to save the record and close the window. 

This prompt will appear. 

 

• Click Yes. 
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Attaching Proposals to Lettings 

To attach proposals to a letting header: 

• Open the Lettings List window  

• Rclick the appropriate Letting. 

• Click Tabbed Folder Change. 

The Letting Tabbed Folder window will 
open. 

 

• Click the Letting Proposals tab. 

 

The Letting Proposals tab page 1 will 
open.  The top part of the Letting 
Proposals tab may be blank like this one, 
or will contain a list of all the proposals 
associated with the letting.  The bottom 
part of the Letting Proposals tab page 
contains detail information for the 
proposal highlighted in the list 

 

To add a new proposal to the letting: 

• Rclick the center of the screen. 

• Click Add 
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The lower part of the screen 
will look like this. 

• Complete the following 
fields on page 1. 

Letting Call Order 
(System generated) 

 

 

 

 

Contract ID     Click the down arrow and 
a list window of all available proposals 
will open.   

• Select the desired proposal. 

• Click OK  

Notice Publication Date      This date will 
transfer to SiteManager as the 
Advertised Date.  Be sure that date 
sequences are in logical order. 

Letting Status  

Status Date  

Pass to CAS/DSS     
Leave the default 
value of "B" until 
the contract is 
ready to transf
SiteManager. 

er to 

The results of these entries 
appear.  

• Click OK. 

The data will be copied to the 
row in the center of the 
window.   

There is no data to be entered now on page 2. 

• Click the X to close the tabbed folder 

• Click YES at the confirmation message 
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Initializing Proposals 

If project-level items are changed after the 
proposal is initialized, the proposal will 
have to be re-initialize to incorporate the 
changes.   

From the Lettings List window: 

• Rclick the Letting that contains 
the proposal(s) to be initialized.   

• Click Letting Proposal List. 

• Rclick the proposal(s) to 
initialize.   

From the Menu Bar 

• Click File > Run Process. 

or 

• Click Run Process from the 
Mouse Button Menu 

 

 

 

 

The Processes window will open. 

• Click Initialize Letting Proposals. 

• Click OK. 

• Click SUBMIT. 

• Click OK to acknowledge progress messages 
when they appear. 

When the process is complete, 

• Click File > Process Status from 
the Menu Bar 

• DblClick the process LASINIT 
that just ran. 
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There are two reports of interest.  The first 
is errors.txt.   

The file size of errors.txt should be zero.  
If it is not, open the file and correct the 
identified errors in the proposal.  Note 
that these are errors that the Trns•port 
system finds and not necessarily data 
errors. 

The second report of interest is 
PRO L

 

rt 
essage, you are ready to 

roceed. 

ll 
ecessary data in the Site tab in PES. 

G.TXT 

g.  Rerun the initialization 
rocess.  

rticular proposal on the Letting 
Hea r

• Rclick Tabbed Folder Change. 

 

C OG.TXT. 

• DblClick the file PROCLOG.TXT.

When you get a PROCLOG.TXT repo
with this m
p

 

 

This example illustrates a major error.  
The report shows that there is no data on 
the Site Tab.  For this example, enter a
n

 

Always open and read the PROCLO
report and correct all errors before 
proceedin
p

 

The Bid Phase 
Identifying the Awardee 

At the pa
de , 
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This tabbed folder will open and show the 
information entered to date. 

To identify the entity to receive the 
MMOA, 

• Click the Generate Estimate Bid 
Tabs button. 

 

 

 

 

The Vendor list window will open.  Note that 
buttons are available to filter and sort this list.  In 
this example, the list was sorted on Vendor 
Name. 

• Highlight the desired entity, taking care 
that the Vendor Number is correct. 

• Click OK. 

 

Bid Tab Detail 

It will not appear that anything has 
changed. 

• Click the Bid Management tab 
and then  

• Click the Bid Tabs radio button. 

The selected vendor now appears as a 
“bidder” with bid tab detail completed. 

• Save and close the tabbed folder. 

 

Bid Tab Edit Report 

From the process list window run the process 
Generate Bid Tab Edit Report. 
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At the Process Status list window, 

• DblClick the process. 

 

 

 

 

• DblClick the file output1.txt. 

 

 

If this bid was on a competitively bid 
contract, the error noted here would be a 
real factor.  For this MMOA, it can be 
ignored.  Note the message “Valid” 

 

 

 

The Bid Tab Report 

Return to the proposal list window and run the 
Generate Bid Tab process 

 

 

 

 

 

At the Process Status list window, 

• DblClick the process. 
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• DblClick the .txt file that contains the 
Proposal ID. 

 

 

 

Review the report for any errors. 

 

 

When everything appears correct, close 
all reports and return to the proposal li
window.  While it is important that these 
two processes have indicated no errors, it 
is equally important that they have set 
fields for transfer to SiteManager. 

st 

 

 

The Award Phase 

At the particular proposal on the Letting 
Header, 

• Rclick Tabbed Folder Change. 

 

• Rclick the Bid Management tab 

Enter information in the following fields: 

• Bid Type enter RESP. 

• Surety Company ID enter the 
appropriate vendor.  For award to 
a county or city where a surety is 
not required enter A000000000. 

• Status of Bid enter W. 

• Insurance Company ID enter the 
appropriate vendor.  For award to 
a county or city where a surety is 
not required enter A000000001. 

• Click the Save       icon to save the 
data. 
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Return to the Tabbed Folder Change from 
the letting proposal list window.  The 
General Tab will appear similar to this 
one, with most fields blank. 

• Click "02" in the Letting Status 
field.  

• Enter the AWARDED date in the 
Status Date field.   

• Click the Awarded Vendor field at 
the down arrow (if it was not filled 
by the Bid Tab Analysis process) 

• Click the City of Wauchula 

• Enter the Awarded Amount if it 
does not fill automatically.   

• Enter the date in the Awarded 
Date field. 

• You may use the optional field 
Mailed Date to indicate the date of 
mailing the award documents to 
the vendor.  Note the format of 
this field is mmddyyyy. 

• Click the Save       icon to save the 
data. 

• Close the tabbed folder.   

The contract is now ready to be marked as executed and transferred to SiteManager. 

 

Executing the contract 

Reopen the tabbed folder 

• In the Letting Status field change 
the value to 03. 

• In the optional Returned Date field 
you may enter the date the 
executed contract documents were 
returned. 

• In the Executed Date field enter 
the appropriate date. 

• Save and close the folder. 
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Transfer the Contract to SiteManager 

When the contract is ready to transfer to SiteManager, 

 Verify that the Generate Preliminary Detail Estimate, Generate Bid Tab Edit, and 
Generate Bid Tab or Generate Bid Tan Analysis processes were run at their proper 
times.  These processes set certain fields for transfer to DSS and SiteManager. 

At the General tab of the letting proposal 
verify that: 

• The Letting Status is 03. 

• The Status Date is the 
AWARDED date. 

• The Awarded Vendor is correct. 

• The Awarded Amount is correct. 

• The Executed Date field is 
properly filled. 

Set the following: 

• In the Pass to CAS/DSS field blank the letter B.  

• Save and close the tabbed folder.   

The contract will be transferred to SiteManager and DSS in the nightly transfer 

 

Managing Vendors 

Every vendor who is a potential bidder must be in the Trns•port Master Vendor file.  
Additionally every vendor who is a sub-contractor must be in the Trns•port Master Vendor file. 

The Trns•port Vendor Interface will pull vendor information from three general sources.  The 
first is the Department’s contractor prequalification program.  The second is MyFlorida Market 
Place or Spurs, and the third is the Division of Corporations at the Department of State. 

For most construction and maintenance contractors the Vendor Numbers have a leading letter V 
in the Trns•port system.  The second character is usually an F or an S.  The F indicates a 
company that is using a Federal Employer Identification Number (FEIN).  These numbers are 
issued by the U. S. Internal Revenue Service.  The S indicates a company that is using a Social 
Security Number as its Tax Identification number.  These companies are often organized as 
either Sole Proprietorships or Limited Liability Corporations (LLC). 

Insurance providers are identified with a leading Z. 

The numeric portion of the Vendor Number is nine positions for the Tax Identification Number 
and a three digit numeric Sequence Number.  The Sequence Number also exists in MyFlorida 
Marketplace and SPURS records.  The Division of Corporations data has no sequence number. 
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The Trns•port Vendor Interface 

To execute the Vendor Interface, go to the 
Trns•port Webgate. 

• Enter your UserId 

• Enter your password  

• Click Submit. 

Note that this password is your mainframe 
password. 

 

 

 

 

• Click Vendor Interface. 

 

 

 

The vendor Interface will open. 

 

 

Refreshing Vendor Data 
To get data from MyFlorida Marketplace, 
Spurs, or the Department’s 
prequalification system use a 13 digit 
number with a leading F or S, nine digits 
for the Tax Identification Number and 
three digits for the appropriate sequence 
number.  In this example F593014108002 
was entered. 

• Click Enter. 
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Enter another vendor number.  In this 
example F591925201001 was entered 

• Click Enter. 

You may do this multiple times.  When all 
desired vendor numbers have been 
entered,  

• Click Submit, 

and a process will commence. 

 

 

 

A new window will open identifying the 
batch process initiated and the job number 
to track.  In this example, the Job Number 
is 8014. 

 

 

• Click Job Output Retrieval 

 

 

 

 
A new window will open showing all jobs 
available for your UserId.  In this example 
there are two. 

 

 

 

To see the report, 

• Click the link at the report title. 
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In this case two vendors were successfully 
refreshed. 

• Close the window by clicking the 
X in the top right corner of the 
window. 

 

To delete completed reports 

• Click the appropriate box in the 
Sel column. 

• Click Delete 

You will be returned to this screen 
showing the vendors that were ready to 
process.  Close the window by 

• Clicking the X in the top right 
corner of the widow. 

 

 

 

New Vendors 
From time to time new vendors will be added to Trns•port that do not preexist in other systems.  
These can now be retrieved by entering the appropriate F or S prefix and the nine digit tax ID but 
not entering a sequence number at the vendor number entry screen above.  This entry will pull 
data from the records of the Division of Corporations in the Department of State.  Verify the 
appropriate number of the Division of Corporation records before you start.  

 

Entering Vendor data directly into Trns•port 

There will be times when a vendor that is 
not in Trns•port or the Department’s 
Vendor File needs to be added to 
Trns•port.  Certain individuals in the 
Central office and in District Contracts 
Administration Offices have security 
authority to enter information into 
Trns•port in the following manner: 
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From the Tool Bar,  

• Click the Vendor icon. 

Or 

From the Menu Bar, 

• Click Edit > Reference Tables > 
Vendor List.   

• Rclick anywhere in the master 
Vendor list  

• Click Tabbed Folder Add. 

 

The General Tab of the Vendor 
Information Detail window will be 
displayed. 

If the vendor has a current Federal 
Employee Identity (FEIN) number, use it 
by adding a prefix of VF and a suffix of 
001 to assign it as a Vendor ID. 

If the vendor does not have a current 
FEIN number, he or she needs to provide 
you with the Social Security Number 
under which he or she files Federal Tax 
returns.  With the SSN, add a prefix of VS and a suffix of 001. 

 Warning.  If a planholder is entered directly into Trns•Port there is a risk that overnight 
processing will mark the vendor as obsolete.  This will occur if the vendor fails to 
register in the MyFlorida Market Place.  This registration is required by State procedures. 

Enter the following minimum number of fields: 

Vendor No.      Enter VF or VS as discussed above and then the numerical number of the 
FEIN or Social Security Number followed by 001. 

Name     The vendor name (short description). 

Long Name     The vendor name (long description). 
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Vendor Type     A value, which must 
be selected from the attached 
VENDTYP code table, which 
indicates the type of vendor.  
Choose CON. 

IRS Number     The Federal 
Employer Identification (FEI) 
number assigned to the vendor 
by the IRS or the vendor’s Soci
Security Number. 

al 

nformation,  

he Addresses tab 

A blank

 the 

When you have completed the 
minimum data, 

• Click OK to accept the 
Vendor data. 

Or 

• Click Add More to add 
another vendor. 

Or 

• Click Cancel to exit. 

 

Adding Vendor Addresses 
To add vendor address i

• Click t
of the Tabbed Folder. 

 screen will open.    

• Rclick Add. 

• On Page 1 fill
following fields: 
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Address Seq. No.      
Address Sequence 
numbers will be used 
as follows.  Sequence 
Number 01 is to be 
used as the Home 
Office address, 
Sequence Number 02 
is to be used as a 
mailing address, and 
Address Sequence 
Number 03 will be 
used for Bidding 
Address. 

If a district needs to add an Address to an existing vendor, or add a new vendor, use Address 
Sequence Number 04 and higher. 

Address Type     A value, 
which must be selected 
from the ADDRTYP 
code table, that 
indicates the type of 
address for the vendor 
(e.g., billing or 
shipping). 

Address     The vendor’s 
address. 

City     The vendor’s city.   

State     The vendor’s state. 

ZIP Code     The vendor’s 
zip code. 

Phone     The vendor’s phone number. 
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• Click the Page 2 radio 
button when completed. 

• On Page 2 enter the Fax 
number 

Fax Number     The 
Vendor’s FAX number 
in the filed labeled 
Long String. 

These two screens illustrate a 
new address for a vendor with 
the use of the OTSH code for 
address type.  The Central 
Contracts Administration O
will enter all vendors into the
Department vendor database
pre-qualified contractors.  A file refresh program will update the Trns•port vendor database each
night.  If the District Office needs to have the database refreshed sooner, it can run the Trns•port 
Vendor Interface (TVI) program and update the vendor database on demand. 

ffice 
 

 for 
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